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Key Guidelines:
see page 3 for visual aid

Please read this document carefully before preparing your files for printing. It will help obtain the best possible 
results while avoiding any unpleasant surprises or additional costs.

• Accepted save formats:      HIgh resolution PDF (No transparency flattening)
        • You may download Lamcom’s Adobe PDF Preset settings or ask your representative to  
          send them to you.  
        • You may send source files, but only the PDF will be used unless we have to make   
          corrections.
        • We do not accept PDF/X format. If, however, this is the only format available, Lamcom  
          cannot be held responsible for pritns that do not meet your expectations.

• Bleed:         0.25’’ on all sides, except:         
        Banners = 0.5’’ on all sides
        Fabrics = 2’’ on all sides
        Murals = 2’’ on all sides
        Adhesives mounted on rigid subtrates = 0.5’’ on all sides

• Margins:       Minimum 0.25” on all sides

• Image resolution:      Maximum 150 dpi at final size
 
• File ratios:       100% ou 10% if the file is too heavy 
        (please advise your representative if that is the case)

• Text:        Always outlined

• One item per page 

• THE PAGE/ARTBOARD SIZE MUST MATCH THE ITEM‘S CUT SIZE. 
   IT MUST MATCH THE DIECUT SIZE IF APPLICABLE; THERE SHOULD BE A 0.25” BLEED ALL AROUND
   See the follwing pages for more details.

• ALL INVISIBLE, HIDDEN, OR UNWANTED LAYERS AND OBJECTS MUST BE REMOVED.
   Lamcom cannot be held responsible if these objects appear on your print if they have not been removed,  as  
our prepress software automatically turns on all layers.

• Please do not include any guidelines or objects that should not be printed.

ALL FILES MUST MEET THESE SPECIFICATIONS; OTHERWISE, ADDITIONAL FEES WILL BE CHARGED 
(65$/HOUR).
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Artboard
Must match the print’s final size 

Text must be outlined

CMYK and RGB documents are acceptable.
Any Pantone colours must be applied
as spot colours in the document. These spots
must be named exactly the same as in the 
Pantone colour library.
ex: PANTONE 7722 C = correct
PMS 7722 C = incorrect
PANTONE 7722 copie = incorrect

**Any important images or copy
must be placed at least 

0.25” away fromthe edge of the artboard
to avoid them being trimmed

Please refer to page 5
for specifications regarding banners. 

Bleed
A 0.25”* bleed is needed on all sides.
Any images or coloured background
on the edge of your document must
exceed its final format by 0.25” on all sides
to avoid a white line when trimming 
* See page 2 for bleed specifications
on different substrates.

Images must have a resolution of
100 to 200dpi at final size.

A file at 10% must therefore have
a resolution of 1000dpi to print at 100dpi.

Images containing text should have
a resolution of150 to 200dpi 

depending on text size. 

A 100% magenta spot colour named
Thru-cut must be applied to the dieline. 
This dieline must be placed in a visible
and printable layer called Thru-cut.
THE DIELINE MUST 
NEVER BE DASHED.

Any crease lines must be printable
and CYAN
THE CREASE LINES MUST 
NEVER BE DASHED.

design standards

X

A DIELINE MUST NOT BE INCLUDED 
ON RECTANGULAR OR SQUARE FILES.

VISUAL AID
See page 4 for more information about page areas and artboards
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Page Areas / PDF Boxes - VERY IMPORTANT
To make sure your file is correctly formatted in regards to the trim and bleed boxes:

You can access the page display preferences dialog by choosing Edit > Preferences (Windows) or Acrobat / Adobe Acrobat Reader > 
Preferences (macOS). Check Show Art, Trim, & Bleed Boxes to display the defined trim and bleed boxes.

Bleed box
Visual area including the bleed margin, which will be trimmed.

Trim box
Specifies the actual print size after trimming

design standards

Where the bleed box must be set
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SPECIFICATIONS FOR BANNERS WITH HEMS OR FOLDS

Below are two examples of banners with top and bottom hems and stitches for 1” dowels

This is what happens

IMPORTANT NOTE:
The hem area 
differs, depending 
on the dowel’s 
diameter
(2X the dowel’s 
diameter + 0.25").
The stitching area 
always measures 1”.

SAFETY ZONE:
Any text, images or 
logos should be 
within the safety 
zone as to not be 
affected by the 
hems or stitches.

All important 
elements are placed 
within the saefty 
zone in this example.

This guideline is 
especially important 
if the banner is 
printed on both 
sides, as elements 
on either side may 
be slightly unaligned.

SAFETY ZONE SAFETY ZONE

Hemming area (2.25”
for 1” dowels)

Stitching area
Always 1”

The woman’s forehead is in both
the stitching and hemming areas,

in which the dowel would be placed .
The logos are also in those areas

at the bottom of the banner.

Stitching area

Hemming area

Stitching area

Hemming area

Hemming area

Stitching area

 • The dimensions of your file must be the same as the banner’s once it’s sewn.
 • Do not include hems or folds in your file. We all add any necessary material. If your banner is 100” long, your file must also be  
  100” long
 • Please make sure that there are no important elements in the hemming or stitching areas.
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COLOUR MANAGEMENT
Colour mismatch sometimes happens during the printing process. Below are some of the possible causes for 
colour differences and ways to avoid them.

1- Your monitor isn’t calibrated and doesn’t accurately display colours.

Uncalibrated monitors may inaccurately display colours (they may be more yellow or bluish, for example), contrast, or brightness. 
Colours printed with calibrated machinery will therefore differ from those displayed on your monitor. A test print can help you 
determine the correct colours.

2- Our equipment’s colour output capabilities differs from your monitor’s colour display capabilities 
If your file includes colours that our printers can’t reproduce, they may be different than what is displayed on your monitor. For 
instance, our printers cannot print fluorescent or metallic colours, yet monitors can display them.

3- You worked with a certain colour profile, but did not assign it when you saved your file.

Colour profiles greatly affect colour output. Therefore, you may not achieve the desired print result if a colour profile is not assigned 
when you save a file.

The blue squares below indicate where you can assign colour profiles. Otherwise, our default output colour profiles (sRGB 
IEC61966-2.1 or Coated GRACoL 2006 (ISO 12647-2:2004)) will be assigned.

Photoshop Illustrator

Below is the path where you can install our colour profiles.
The oranges squares below indicate where you can select the profiles in Photoshop and Illustrator. 

(Next page)
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InDesignAcrobat

COLOUR MANAGEMENTS continued

4- Saving: 

When using colour profiles, not only is it important to use the proper settings in the editing programs, but it is also critical to check 
the correct save options to embed the proper profiles. Colour output may differ from displayed colours if those options are not 
selected.

Below are the options to select when saving a file:

When saving a Photoshop image to PDF:        When saving a PDF file from another program:
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Any objects printed with white ink must be placed in a separate layer called White_ink. All objects on this layer must be 
overprinted over the objects in CMYK.

It must also be the top layer in your document.

 

Steps to create objects in white ink:

White ink is cosidered a fifth colour. It must therefore be set up in a specific way so that it is not taken into account during 
CMYK processing, yet recognized as a fifth colour during output.

• White ink on the entire print surface
Please notify your representative and we will take care of it.

• White ink only in certains areas of your file:
Please notify your representative that your document contains objects to printed in white ink.
VERY IMPORTANT: Those areas will be invisible in Acrobat if left white, and therefore won’t print. 

White ink in Illustrator and InDesign
Create a new cyan spot colour called White_Ink for the white ink to be visible.
Note: This colour must be named as above for the rip to recognize it during output.

Like such: You can copy-paste this square
to make sure you have
correct colour. 
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Method in Illustrator or InDesign (continued)

How to set an object to overprint

Open the Attributes panel from the Windows menu in Illustrator. 
Select the object(s) that you want to overprint. In the Attributes panel, select Overprint Fill, Overprint Stroke, or both. You can 
select all the objects in the White_ink layer and overprint them.

You can check if the objects are overprinted by using the Overprint Preview mode (View > Overprint Preview) The objects in 
white ink should be transparent over your objects in CMYK.

Keep the layers when saving your file as a PDF, and make sure your file is not saved as PDF/X, as mentioned previously in 
the design standards.
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Method in Photoshop
Objects in white ink can be added by creating a new spot channel. This channel must be named White_Ink. 
Edit all objects that must be printed in white ink in this channel, including those that have white ink under the colour. 
By convention, 100% cyan is used for the White_ink channel
Example:
 

 

 

If the Photoshop files must be placed in an Illustrator file:
Save the file in .tiff and check the Spot Color box to preserve the white ink channel. The channel will then be visible when 
placing the file in Illustrator.

If the Photoshop file is the final document:
Save the image as a PDF and check the Spot Color box to preserve the white ink channel.
IMPORTANT: do not save as PDF/X, as mentionned in the design standards. 
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Method in Photoshop (continued)ZONE

SÉCURITAIRE
POUR

VISUEL

How to set up overprinting

Select the object(s) that you want to overprint. In the Attributes panel, select Overprint Fill, Overprint Stroke, or both.Utiliser la 
You can easily select all objects in the White_Ink layer and set them to overprint.

You can check the overprinted objects by using the Overprint Preview mode (View › Overprint Preview). The objects in white 
ink should be transparent over the CMYK image.

When saving your file as a PDF, preserve all layers and make sure that it is not a PDF/X, as specified in the design standards. 

 

 

Create a White_Ink layer and place any white ink objects.

This layer must be the first one the Layers panel.

Select all objects in the White_Ink layer and set them to Overprint.

Placing a Photoshop image containing white ink in an Illustrator file

Place the image in Illustrator and embed it to the file.
The white ink channel should appear in the swatch library in Illustrator.
There should also be two links in the Links panel: the CMYK portion of the image and the white ink portion.
See below:

CAUTION: it is very important to check that the blending mode for the white ink image is set to normal.
See below:
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Method in Illustrator or InDesign

There are two options if a file contains Braille:

Option 1 : You can have a certified company validate the Braille text

Option 2 : You can mandate Lamcom to have the Braille text validated by a certified company. Note that this option will incur 
additional fees. 

 

Embossing and/or varnish in Illustrator or InDesign

Create a new spot colour named ”Braile” (for embossing) or ”Varnish” (for varnish).

Note: These colours must be named as above for the rip to recognize them during output.

Apply the below spot colours so that the embossed or varnished objects are visible.
 

Like such :

Steps to create embossed and/or varnished objects:

It is important to understand that embossed and varnished objects are to be treated as colours separate from CMYK. 
Therefore, these objects must be set up in a specific way so that they are not taken into account during CMYK processing, 
yet recognized as additional colours during output.  The embossed and/or varnished objects must be edited as spot colours 
and must either be named ”Braille” or ”Varnish”.
 

How to prepare files containing embossing and/or varnish 
Please advise your representative when your files contain objects that have embossing and/or varnish.
VERY IMPORTANT: Never create these objects in white, as they will be invisible when opening your file in Acrobat.

You can copy-paste these squares
to make sure you have
correct colours. 

Braille Varnish 
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Method in Illustrator or InDesign

When creating your file, place embossed or varnished objects in a layer separate from the CMYK objects. All objects in the 
new layer must be overprinted.

These layers must be placed on top of the other layers in the file.

How to set an object to overprint

Open the Attributes panel from the Windows menu in Illustrator. 
Select the object(s) that you want to overprint. In the Attributes panel, select Overprint Fill, Overprint Stroke, or both. You can 
select all the objects in the Braille or Varnish layer and overprint them.

You can check if the objects are overprinted by using the Overprint Preview mode (View > Overprint Preview) The embossed 
or varnished objects should be transparent over your objects in CMYK.

Keep the layers when saving your file as a PDF, and make sure your file is not saved as PDF/X, as mentioned previously in 
the design standards.

If you file also contains white ink, please see the instructions regarding those objects. Objects in white must be placed in a 
separate layer named White_Ink as described in the standards. 

Keep the layers when saving your file as a PDF, and make sure your file is not saved as PDF/X, as mentioned previously in 
the design standards.
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Method in Illustrator or InDesign

Façon matricielle (Photoshop)
Le relief et le vernis peuvent être édités avec Photoshop en créant un Alpha Channel de couleur spot (Nouvelle couche de ton 
direct).
Ces couches doivent absolument être nommées Braille (dans le cas du relief) ou Varnish (dans le cas du vernis).
Éditez dans les couches respectives tous les éléments qui doivent imprimer en relief ou en vernis. Par convention, la couleur 
associé à la couche de Braille est 100% noir et celle pour le vernis est 100% jaune.
Exemple:
 

 

 

Dans le cas où votre document Photoshop est votre document final.
Sauvegardez l’image en pdf en cochant ‘’Tons directs’’ et ‘’Calques’’  pour que la couche de relief et/ou vernis soit conservée 
lors de la sauvegarde. 

Il faut comprendre que le relief dans un document matriciel sera traité de façon à ce que tout ce qui est à 100% dans la 
couche de ton direct nommé «Braille» aura la hauteur maximal. Donc l’opacité dans cette couche correspond à la hauteur du 
relief. Ne jamais éditer des perles de braille en matriciel.

La couche de vernis offre un maximum de lustre si sa surface est à 100%. Des effets peuvent être créer en variant les 
tonalités dans la couche de vernis avec des zones à 100% et d’autres plus pâles donc moin lustrées.

Dans le cas où votre document Photoshop doit être intégré à un document Illustrator:
Sauvegardez l’image en .tiff en cochant ‘’Tons directs’’ pour que la couche la couche de relief et/ou vernis soit conservée lors 
de la sauvegarde et ainsi visibles lors de l’importation dans Illustrator.
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Créer un calque (layer) nommé «Braille» ou «Varnish» pour vos éléments en Relief ou vernis et y mettre la partie de votre 
image qui y correspond.

Ces calques (layers) doivent être au-dessus de tous les autres calques de votre document.

Sélectionner les éléments contenus sur les calques (layers) Braille ou Varnish et tout mettre ces éléments en surimpression 
(overprint).

Comment mettre un élément un surimpression (overprint)

Utiliser la palette «OPTIONS D’OBJET» qui se trouve dans le menu «Fenêtre» de Illustrator.
Sélectionner l’objet que vous désirez mettre en surimpression et cocher la case Surimpresion de Fond et/ou Surimpression 
de coutour. Vous pouvez facilement sélectionner tout le contenu de votre layer White_Ink et tout mettre en surimpression.

Vous pouvez vérifier que vos éléments sont bien en surimpression (overprint) en activant «l’apperçu de la surimpression» 
dans le menu «Affichage». Vos éléments en encre blanche devraient être en transparence sur vos éléments CMYK.

Si votre document contient aussi de l’encre blanche, veuillez vous référer aux normes concernant la création de visuels avec 
encre blanche. L’encre blanche doit se retrouver sur un layer distinct, nommé White_Ink, tel que mentionné dans nos normes. 

Sauvegardez votre document en pdf en conservant les layers et en vous assurant qu’il n’est pas en PDF/X, tel que 
mentionné dans les normes graphiques. 

Intégrer une image Photoshop contenant du relief et/ou vernis dans un document Illustrator

Importez votre lien dans Illustrator et incorporez (embed) le lien à votre document.
Votre couche de ton direct relief nommée «Braille» et/ou la couche de vernis nommée «Varnish» a bien été créer si vous 
voyez apparaître la couleur en ton direct (spot) dans le nuancier de Illustrator.
Dans votre palette de liens votre image devra devenir 2 liens (ou 3 liens), soit la partie CMYK de votre image et la partie de 
ton direct préparé précédemment dans Photoshop soit «Braille» et/ou «Varnish» .
Comme ceci:

ATTENTION: Il est très important de vérifier suite à l’incorporation de votre image que le mode de transparence de votre 
image en «Braille» et/ou «Varnish» est bien à normale.
Comme ceci:


